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iSeries Navigator for Wireless

With iSeries™ Navigator for Wireless, administrators have even more flexibility in how they access and
interact with Management Central.

Managing multiple systems is one of the more
challenging aspects of running a growing business. IBM®
introduced Management Central to help administrators
manage their systems. Users have enjoyed the ease,
flexibility, and power of Management Central. From
managing fixes and running commands across multiple
systems to viewing real-time graphs of their systems
performance, administrators have used Management
Central to do their jobs much more efficiently.

With iSeries Navigator for Wireless, administrators have even more flexibility in how they access and
interact with Management Central. iSeries Navigator for Wireless allows administrators to remotely
monitor and manage system performance, status, jobs, and messages using an Internet-ready telephone, a
personal data assistant (PDA) with a wireless modem, or a traditional Web browser on a workstation.

After you have configured iSeries Navigator for Wireless to run on a Web server on your central system,
you can simply enter the URL into your Internet-ready telephone, PDA, or browser to perform the
following:

* Watch system status.

* View properties of the system.

* View detailed summaries of the following Tasks:

Commands

Packages and Products
Inventory

Fixes

Collection Services
Users and Groups
System Values

+ Manage Integrated xSeries® Servers for iSeries. Run commands on all Integrated xSeries Servers at the
same time or on just a single Integrated xSeries Server, start the Integrated xSeries Servers, or shut
them down.

* Run i5/0S™ commands across multiple systems.

* View and interact with monitors

© Copyright IBM Corp. 2002, 2006

System monitors: View the metrics and current values being monitored, as well as the top 20 items
(jobs, disk units, and so forth) that make up the metric value. Work with jobs listed in the monitor
(display details, hold, release, end).

Job and message monitors: View all jobs and messages across systems matching monitor criteria.
See metrics and current values being monitored. Work with the jobs and messages listed in the
monitor (display details, hold, release, end, delete, reply).

File monitors: View detailed status of files, including system path, size, date modified, and the text
that triggered the file.



— B2B activity monitors: View business-to-business transaction details, and see metrics and current
values being monitored.

* Limit what users can do by enabling read-only support, or by setting user-access levels with
Application Administration. Allow users to view status information without the ability to take action.

This information is intended to help you start using iSeries Navigator for Wireless by providing tips on
which devices to use, how to install and configure the required elements, and by giving you an overview
of the functions.

What’s new for V5R4

Share multiple monitors across multiple users when using iSeries Navigator for Wireless.

New in V5R4, you can configure your iSeries Navigator for Wireless to share multiple monitors across
multiple users. This new feature allows you to see shared monitors along with ones that you have
created. For more on these new easy setup instructions, choose a Web application serverf

How to see what’s new or changed

To help you see where technical changes have been made, this information uses:
e The ¥ image to mark where new or changed information begins.
¢ The 4% image to mark where new or changed information ends.

To find other information about what’s new or changed this release, see the

Printable PDF

Use this to view and print a PDF of this information.

To view or download the PDF version of this document, select [iSeries Navigator for Wireless| (about 637
KB).

Other information

You can view or print PDFs of related manuals and Redbooks™" from the [Related information pagel

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click the link above).

2. Click Save Target As if you are using Internet Explorer. Click Save Link As if you are using Netscape
Communicator.

3. Navigate to the directory in which you would like to save the PDF.
4. Click Save.

Downloading Adobe Acrobat Reader

You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the
(www.adobe.com/products/acrobat/ reads’cep.html)-.lijr .
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Set up iSeries Navigator for Wireless

Covers the software and hardware that is required to use iSeries Navigator for Wireless. This also helps
you decide which kind of wireless device to use and what kind of applications you may need to install
and configure.

There are many choices to make when entering the wireless world. This section describes what is
required to use iSeries Navigator for Wireless, as well as helps you decide which kind of device to use
with iSeries Navigator for Wireless. The following pages also help you to determine what kind of
applications you may need to install and configure.

Related concepts

[‘Manage iSeries Navigator for Wireless” on page 18|

Find out how to manage iSeries systems from a wireless device. Use iSeries Navigator for Wireless to
interact with monitors in both Management Central and Integrated xSeries Servers. Run commands,
work with tasks and systems, and control user access.

Hardware and software requirements

Determine if you have all the necessary software and hardware to run iSeries Navigator for Wireless.

The following elements are required to run the latest enhancements of iSeries Navigator for Wireless:

* Licensed Product 5722-XP1: The iSeries Access for Wireless product that includes iSeries Navigator for
Wireless.

* A device to run the function
— An Internet-enabled telephone with a wireless internet service
— A PDA with a web browser, a wireless modem, and a wireless internet service
— A traditional web browser on a workstation

¢ A server running i5/0S V5R2 or later in a TCP/IP network. This will be your central system used by
Management Central.

* A web application server running on your central system, such as any of the following:
— ASF Jakarta Tomcat Application server
— WebSphere® Application Server
— Any other application server that runs on the central system, having the capability to host servlets
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Figure 1. Wireless device connecting to Management Central

Select a device

Choose devices that are compatible with iSeries Navigator for Wireless.

Internet-ready telephones and wireless PDAs are a rapidly changing technology. They differ in screen
size, in look-and-feel, and in many other significant characteristics. The following sections help you
choose devices that are compatible with iSeries Navigator for Wireless. Other wireless devices may also
be compatible if they support wireless internet browsing, but the interaction may be different.

Select a Device: Internet-ready telephones
Select an Internet-ready telephone to use with iSeries Navigator for Wireless.

Consider the following elements when you select an Internet-ready telephone to use with iSeries
Navigator for Wireless:

* The physical characteristics of the telephone itself (display size, button location, and so forth)
* The web browser (often called a microbrowser or a minibrowser) supported on the telephone

* The wireless internet services available with the Internet-ready telephone in the geographical areas
where you want to use it

The display size of the Internet-ready telephone often affects how easy it is to use. In general, the more
horizontal lines the telephone displays, the easier it is to view data. Regardless of the display size, you

will often need to scroll down in the telephone display using buttons or other scrolling mechanism. The
width of the displayed lines should also be a consideration.
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An Internet-ready telephone is typically already loaded with a microbrowser. Once you select a particular
telephone, you are also making your browser choice. iSeries Navigator for Wireless currently supports the
Openwave Mobile Browser version 3.1 and above (formerly called UP.browser). For best results, choose a
telephone that supports this microbrowser.

The wireless internet service is what transports the data to and from your Internet-ready telephone. It is
not the same as the voice service for your telephone, although the two may be packaged together by a
particular provider. Make sure that the telephone you select is supported by a wireless internet service
available in the geographical areas where you want to use it.

Compatibility with iSeries Navigator for Wireless

The following Internet-ready telephones are compatible with iSeries Navigator for Wireless.

Telephone Type of testing Wireless service Comments
Mitsubishi T250 Device AT®&T PocketNet Small font preference is
recommended.

Note: Other phones have been tested with a simulator, including the Ericsson R280 LX.

Other Internet-ready telephones may also be compatible. As stated earlier, iSeries Navigator for Wireless
supports the Openwave Mobile Browser 3.1 or greater from Openwave. The Openwave Mobile Browser
is licensed by a number of telephone manufacturers around the world. In addition, many of the
manufacturers offer support on more than one model of telephone. The list of telephones supported by
the OpenWave Mobile Browser can be found at the Openwave Web site

http:/ /upmkt.openwave.com/dev_phones/phones.cfm . Other information on this browser can be found
at the Openwave Web site: http:/ /www.openwave.com.

Related information

[http:/ /upmkt.openwave.com/dev_phones /phones.cfm|

[http:/ /www.openwave.com|

Select a Device: PDAs
Select a PDA to use with iSeries Navigator for Wireless.

iSeries Navigator for Wireless makes use of a web browser running on your PDA. Unlike Internet-ready
telephones, the selection of a browser is not tied to your choice of PDA device. If a web browser was
packaged with your PDA when you bought it, you can install additional web browsers. You can
download many web browsers for PDA devices over the Internet.

PDA browser compatibility with iSeries Navigator for Wireless

Many different web browsers exist for PDA devices. Often, the browsers differ in the HTML elements
they support. Some browsers handle text differently than others. Some display images and tables, while
others do not. Some browsers offer higher levels of protection or security than others. The following
browsers support the necessary elements to run iSeries Navigator for Wireless from a PDA:

* AvantGo Version 3 or later

* EudoraWeb Version 1.1 or later

¢ Go.Web Version 6.0 - for RIM Blackberry

Other web browsers that run on PDAs may also be compatible. Be aware that the differences in how
another browser displays HTML can cause iSeries Navigator for Wireless to appear and behave

differently than one of the browsers listed previously.

Also, if you need extra security look for browsers that support SSL.
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PDA compatibility with iSeries Navigator for Wireless

The following PDAs are compatible with iSeries Navigator for Wireless:

PDA Operating system Wireless modem Wireless service
Palm V or Vx Palm OS Version 3.3 Minstrel V AT&T

Palm III or IIIx Palm OS Version 3.3 Minstrel IIT AT&T

RIM Blackberry RIM Built in GoAmerica
Kyocera QCP 6035 Palm OS Built in Sprint

Many other PDAs are most likely compatible. Since iSeries Navigator for Wireless runs in a browser, the
choice of PDA should not make a difference, but only the PDAs listed above were tested. Also, any
device that allows you to perform web browsing and supports HTML may be compatible with iSeries
Navigator for Wireless.

Modem and wireless Internet service for the PDA

You need to choose a modem that is compatible with your PDA selection. In addition, you need to find a
wireless Internet Service Provider (ISP). The wireless Internet service transports the data to and from
your PDA using the modem. When choosing a modem and service, make sure that you select a
combination that is supported in the geographical areas where you want to use your PDA.

Related information

[EudoraWeb
0.Web

Select a Device: PCs
You can also use a traditional web browser with iSeries Navigator for Wireless.

IBM iSeries Navigator for Wireless is designed to run on an Internet-ready telephone or PDA. However,
because it runs on a browser in a PDA, iSeries Navigator for Wireless will also run on a traditional web
browser. Any current workstation web browser should work because PDA browsers have more
limitations.

Because iSeries Navigator for Wireless only needs a small display, one suggestion is for you to put a
small window of your browser in the corner of your workstation. Then you can keep current on your
systems and monitors without having to clutter your desktop.

If you are using a traditional Internet browser on your PC, you can select Get Report from the main
menu to display all information on a full browser screen.

Develop an Internet protection program

Develop an internet protection program that works for you.

Because the iSeries Navigator for Wireless servlet needs to obtain the user ID of the remote user, the web
application server will need to be configured or set up to authenticate the user. The servlet uses this user
ID to communicate with Management Central. Because this authentication can take place over the
internet, the user needs to develop a protection plan to protect this authentication information (user ID
and password).

Also, the data that is transferred between the client and the server contains systems management
information. An analysis should be done to determine the level of protection you require for this data.
The following questions need to be considered in developing this plan.
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* What services will be used to access the servlet (use the Internet, use browsers on clients attached to
the central system, or both)?

* What client devices will be used and what are the security capabilities of the browsers used on the
devices?

* How will the desired protection be configured or be set up on a Web application server such as IBM
WebSphere or ASF Tomcat servlet engine, and IBM HTTP Server for iSeries?

* What is the sensitivity of the data transferred between the client and server?
In developing this protection plan, refer to i5/0S Internet Security Scenarios: A Practical Approach®.

The following IBM WebSphere Application Server web page and ASF Jakarta Tomcat home page may
also be helpful in developing a protection plan. These pages also provide documentation on the security
protection capabilities of the client devices and browsers to be used.

Related information

AS/400 Internet Security Scenarios: A Practical Approach|
[BM WebSphere Application Server]
[ASF Jakarta Tomcat]

Configure your wireless environment

Modify your web application server and firewall configuration so that iSeries Navigator for Wireless will
run properly.

Before you begin using iSeries Navigator for Wireless, make sure that you have properly configured or
set up the following items. After you have completed these steps, you are ready to connect to your
central system and begin using iSeries Navigator for Wireless:

Related concepts

[‘Connect to your central system” on page 14|
Connect to the central system using your wireless device.

[‘Configure your ASF Jakarta Tomcat servlet engine for HTTP Server (powered by Apache)’|
Create and configure the servlet engine for your wireless network.

[‘Configure your WebSphere Application Server, Base Edition, Version 5.0” on page 9|
Create and configure an HTTP server using WebSphere Application Server for your wireless network.

[‘Configure your WebSphere Application Server, Express Edition, Version 5.0” on page 10|
Create and configure an HTTP server using WebSphere Application Server Express Edition for your
wireless network.

Choose a Web application server

Set up iSeries Navigator for Wireless to run using an ASF Jakarta Tomcat servlet engine, or a WebSphere
Application Server (WAS). You can find set up instructions here for WAS 5.0 Base Edition and WAS 5.0
Express Edition.

You can use several Web application servers to run the iSeries Navigator for Wireless servlet. The
following Web application servers are recommended:

Related tasks

[“Configure Management Central” on page 12|

Take full advantage of the capability that iSeries Navigator for Wireless provides when you interact
with Management Central. This page helps you to fully use the functions available in Management
Central.

Configure your ASF Jakarta Tomcat servlet engine for HTTP Server (powered by Apache):

Create and configure the servlet engine for your wireless network.
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The following tasks will help you set up an ASF Tomcat servlet engine for HTTP Server (powered by
Apache) to run iSeries Navigator for Wireless:

Requirements

Before you begin, you must have QSECOFR authority and the following installed:
e IBM HTTP Server (5722-DG1)

Note: The following instructions will create a new instance of an HTTP Server; you cannot use the
following instructions to set up iSeries Navigator for Wireless on an existing HTTP Server.

Create your Web application server

Running the following command will add the iSeries Navigator for Wireless servlet to the Apache
Software Foundation Jakarta Tomcat servlet engine. It will also set up an IBM HTTP server (powered by
Apache) named <HTTPInstanceName> that listens for requests on port <port number>. Items in [brackets]
are optional, and if you do not specify a value, a default value will be used. Replace items in <italics>
with your own information:

CALL QSYSDIR/QYPVSETUP '-tomcat [-httpinstance <HTTPInstanceName>] [-port <port
number>] [-javaversion <java version>]"'

The parameters in the command above are defined as follows:

-tomcat
Specifies that ASF Tomcat is the servlet engine used to run iSeries Navigator for Wireless.

-httpinstance <HTTPInstanceName>
Specifies the name of the HTTP instance used to run the ASF Tomcat servlet engine. If you do not
specify an instance name, the default is MCP. When specifying an instance name, the name
cannot include spaces and must be less than 10 characters long.

-port <port number>
Specifies the port for the HTTP Server to listen for requests. If the port is not specified, the
default is 8110.

-javaversion <java version>
Specifies the version of Java' Developer’s Kit to use. Valid values for this parameter are 1.3 and
1.2. If you do not specify a java version, the default is 1.3 if it is installed, otherwise 1.2 will be
used.

Start your Web application server

ASF Tomcat runs "in process’; this means that it starts and ends when the HTTP server starts and ends.
After you run the above command and setup is complete, you need to start the HTTP Server by running
the following command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your web application server, you can continue to configure your
wireless environment.

For more information about ASF Jakarta Tomcat, go to http://jakarta.apache.org/tomcat/index.html.
Related concepts

[“Configure your wireless environment” on page 7|
Modify your web application server and firewall configuration so that iSeries Navigator for Wireless
will run properly.

Related information

[http:/ /jakarta.apache.org /tomcat/index.html]|
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Configure your WebSphere Application Server, Base Edition, Version 5.0:
Create and configure an HTTP server using WebSphere Application Server for your wireless network.

The following tasks will help you set up iSeries Navigator for Wireless to run using WebSphere
Application Server (WAS) 5.0 Base Edition:

Requirements

Before you begin, you must have QSECOFR authority and the following installed:
* IBM HTTP Server (5722-DG1)
* WebSphere 5.0.1 and above

Note: The following instructions will create a new instance of an HTTP Server; you cannot use the
following instructions to set up iSeries Navigator for Wireless on an existing HTTP Server.

The following instructions assume you have configured and are running WebSphere already. If you have
not yet set up WebSphere, go to WebSphere at

http:/ /www.ibm.com/eserver/iseries/products/websphere for complete prerequisite details (including
Java). The WebSphere Administrative Console program installed on a PC (that is, Windows NT® on the
TCP/IP network) should be used in the setup and configuration.

If you are a new WebSphere user, make the Hello World servlet application functional by following the
configuration steps on the WebSphere homepage. This setup process helps you to become familiar with
WebSphere, and it verifies that the installation and configuration are successful.

Start the WebSphere subsystem

Make sure the QEJBAS5 subsystem is running. If it is not running, run the following command:
STRSBS QEJBAS5/QEJBAS5

Create your Web application server

Running the following command will set up iSeries Navigator for Wireless to run using WebSphere 5.0
Base Edition as the servlet engine. It will create an instance of WebSphere named <WASInstanceName>
and an IBM HTTP Server (powered by Apache) named <HTTPInstanceName> that listens for requests on
port <port number>. Make sure that subsystem QEJBAS5 is running before trying this command. Items in
[brackets] are optional, and if you do not specify a value, a default value will be used. Replace items in
<italics> with your own information:

CALL QSYSDIR/QYPVSETUP '-wasversion 5733WS5 [-nodename <node name>] [-wasinstance
<WASInstanceName>] [-httpinstance <HTTPInstanceName>] [-port <port number>]'

The parameters in the command above are defined as follows:

-wasversion 5733WS5
Specifies that Websphere 5.0 Base Edition will be used to run iSeries Navigator for Wireless.

-nodename <system name>
Specifies the short name of the system that iSeries Navigator for Wireless is being set up for. For
example, if the system name is yoursystem.yourcompany.com, the <system name> would be your
system.

-wasinstance <WASInstanceName>
Specifies the name of the WebSphere instance that will be created to run iSeries Navigator for
Wireless. The instance that is specified cannot exist yet, otherwise there will be an error when the
command is run. If you do not specify an instance name, the name of the instance will be MCP.
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-httpinstance <HTTPInstanceName>
Specifies the name of the HTTP instance used to run the WebSphere servlet engine. If you do not
specify an instance name, the default is MCP. When specifying an instance name, the name
cannot include spaces and must be less than 10 characters long.

-port <port number>
Specifies the first number of a block of 6 ports. The HTTP Server will listen for requests on <port
number>, and the application server listens on <port number> + 1 through <port number> + 5. If
you do not specify a port number, the default is 8110 for the HTTP Server and 8111 - 8115 for the
application server.

Start the WebSphere application server

To start your application server, you need to run this command from the QSHELL command line:
/QIBM/ProdData/WebAS5/Base/bin/startServer iSeriesNavigatorForWireless -instance <WASInstanceName>

The port number for the admin console of this instance of the WebSphere application server will be
displayed once the application server has started.

Start your HTTP Server

After you start your application server, you need to start your HTTP Server by running the following
command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your web application server, you can continue to configure your
wireless environment.

Related concepts

[‘Configure your wireless environment” on page 7|
Modify your web application server and firewall configuration so that iSeries Navigator for Wireless
will run properly.

Related information

[http:/ /www.ibm.com /eserver /iseries/products/websphere]|

Configure your WebSphere Application Server, Express Edition, Version 5.0:

Create and configure an HTTP server using WebSphere Application Server Express Edition for your
wireless network.

The following tasks will help you set up iSeries Navigator for Wireless to run using WebSphere
Application Server (WAS) 5.0 Express Edition:

Requirements

Before you begin, you must have QSECOFR authority and the following installed:
e IBM HTTP Server (5722-DG1)
* WebSphere 5.0.1 and above

Note: The following instructions will create a new instance of an HTTP Server; you cannot use the
following instructions to set up iSeries Navigator for Wireless on an existing HTTP Server.

The following instructions assume you have configured and are running WebSphere already. If you have

not yet set up WebSphere, go to WebSphere at
http:/ /www.ibm.com/eserver /iseries /products/websphere for complete prerequisite details (including
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Java). The WebSphere Administrative Console program installed on a PC (that is, Windows NT on the
TCP/IP network) should be used in the setup and configuration.

If you are a new WebSphere user, make the Hello World servlet application functional by following the
configuration steps on the WebSphere homepage. This setup process helps you to become familiar with
WebSphere, and it verifies that the installation and configuration are successful.

Start the WebSphere subsystem

Make sure the QASES5 subsystem is running. If it is not running, run the following command:
STRSBS QASE5/QASE5

Create your Web application server

Running the following command will set up iSeries Navigator for Wireless to run using WebSphere 5.0
Express Edition as the servlet engine. It will create an instance of WebSphere named <WASInstanceName>
and an IBM HTTP Server (powered by Apache) named <HTTPInstanceName> that listens for requests on
port <port number>. Make sure that subsystem QEJBAS5 is running before trying this command. Items in
[brackets] are optional, and if you do not specify a value, a default value will be used. Replace items in
<italics> with your own information:

CALL QSYSDIR/QYPVSETUP '-wasversion 5722IWE [-wasinstance <WASInstanceName>]
[-httpinstance <HTTPInstanceName>] [-port <port number>]"'

The parameters in the command above are defined as follows:

-wasversion 5722IWE
Specifies that Websphere 5.0 Express Edition will be used to run iSeries Navigator for Wireless.

-wasinstance <WASInstanceName>
Specifies the name of the WebSphere instance that will be created to run iSeries Navigator for
Wireless. The instance that is specified cannot exist yet, otherwise there will be an error when the
command is run. If you do not specify an instance name, the name of the instance will be MCP.

-httpinstance <HTTPInstanceName>
Specifies the name of the HTTP instance used to run the WebSphere servlet engine. If you do not
specify an instance name, the default is MCP. When specifying an instance name, the name
cannot include spaces and must be less than 10 characters long.

-port <port number>
Specifies the first number of a block of 6 ports. The HTTP Server will listen for requests on <port
number>, and the application server listens on <port number> + 1 through <port number> + 5. If
you do not specify a port number, the default is 8110 for the HTTP Server and 8111 - 8115 for the
application server.

Start the WebSphere application server

To start your application server, you need to run this command from the QSHELL command line:
/QIBM/ProdData/WebASE/ASE5S/bin/startServer <WASInstanceName> -instance <WASInstanceName>

The port number for the admin console of this instance of the WebSphere application server will be
displayed once the application server has started.

Start your HTTP Server

After you start your application server, you need to start your HTTP Server by running the following
command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

iSeries Navigator for Wireless 11



Now that you have finished setting up your web application server, you can continue to configure your
wireless environment.

Related concepts

[‘Configure your wireless environment” on page 7|
Modify your web application server and firewall configuration so that iSeries Navigator for Wireless
will run properly.

Related information

Ihttp: / /www.ibm.com/eserver/iseries/products/ websphere|

Configure your firewall
Determine if you need to modify your firewall to gain access to systems from a wireless device.

When you use iSeries Navigator for Wireless, you will be accessing at least one of your systems from the
Internet. If you access any of your systems from the Internet today, you probably have a firewall set up
to prevent unauthorized access. Depending on your firewall configuration, you may have to modify your
firewall setup to run iSeries Navigator for Wireless.

If you have never accessed your systems from the Internet and do not have a firewall set up, the
following IBM Redbook provides strategies for doing so in the chapters about screened host architecture
and screened subnet architecture. See AS/400® Internet Security Scenarios: A Practical Approach.

Related information

[AS/400 Internet Security Scenarios: A Practical Approach|

Configure Management Central
Take full advantage of the capability that iSeries Navigator for Wireless provides when you interact with
Management Central. This page helps you to fully use the functions available in Management Central.

iSeries Navigator for Wireless does not need a PC to run, but a PC is needed to set up Management
Central. Management Central is an integral part of iSeries Navigator, the graphical interface for iSeries
servers. You install iSeries Navigator on the PC as a component of iSeries Access for Windows®. No
additional installation is needed. When installing iSeries Access for Windows, select iSeries Navigator
from the list of available components, and then select the components you want (Monitors, Commands).
Next, you can set up Management Central (central system, endpoint systems, monitors, commands). To
connect to Management Central from a wireless device, your Web application server must be set up on
the endpoint server you have configured as your Management Central central system.

Because iSeries Navigator for Wireless is a companion to Management Central, iSeries Navigator for
Wireless uses endpoint systems and monitors defined in Management Central to report status and to
monitor metric information.

Do the following tasks in Management Central before you begin using your wireless device:
1. Add endpoint systems

Add systems to your network so that you can monitor status. Only systems defined as endpoint
systems in Management Central will show up in iSeries Navigator for Wireless. This includes systems
with integrated xSeries servers. If you want to manage your integrated servers on a particular system,
be sure it has been added as an endpoint system.

When all of your endpoint systems have been added, collect inventory so information about each
endpoint system is available for you to view from iSeries Navigator.

2. Create monitors

Monitors in Management Central can be powerful. You have the flexibility to have simple or complex
monitors, to set up thresholds, and to perform automation if those thresholds occur. The goal of
iSeries Navigator for Wireless is to keep you informed of the status of these monitors wherever you
are. Create monitors with meaningful names (but try to keep them short or they will scroll on the
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wireless devices). When you give a monitor a meaningful name, you can easily recognize it on a
wireless device, and you will know what it is monitoring for, if it has triggered, and the severity of a
problem you are looking at. With iSeries Navigator for Wireless, you can also view metrics and values
on a specific system.

Start and stop monitors

You have the ability to start and stop monitors from iSeries Navigator for Wireless, but if you start
them in Management Central, your monitors will be active and on the lookout for problems, and data
will have already been collected when you access your monitors from a wireless device. Many times a

problem will occur and you will need to monitor something in more detail. If you predefine these
"troubleshooting” monitors in Management Central, you can then start them later using iSeries

Navigator for Wireless.
4. Create command definitions

You can run commands from iSeries Navigator for Wireless. However, entering a long command into
a Internet-ready telephone can be quite cumbersome. That is why your command definitions are also
displayed so you can run the commands in the definitions directly from iSeries Navigator for

Wireless. Create as many command definitions as you would like, but keep the names short so you

can see them on a small display.

Related concepts

[Management Centrall

[‘Choose a Web application server” on page 7|

Set up iSeries Navigator for Wireless to run using an ASF Jakarta Tomcat servlet engine, or a
WebSphere Application Server (WAS). You can find set up instructions here for WAS 5.0 Base Edition

and WAS 5.0 Express Edition.
Related tasks
[[nstall iSeries Navigator]|

[Add endpoint systems|

[Create monitors|

[Create command definitions|

Select a language

The default language is set to English, but you can configure your device to display your language of

choice.

The iSeries Navigator for Wireless default language is English, but you have the ability to select different
languages. Once you install the optional language support fix (PTF), the language can be set on the

device being used, the browser used on your PC, or specified on the URL. Use the following URL and

language choice:

host . domain : port/servlet/McYpvPervasive?Ing= lang

host: The host name of the central system

domain: The domain the central system is located

port: The port that the instance of the Web server is listening to

lang: The language to be viewed

Available languages:

Language Language identifier Character set
Belgium Dutch nl_BE 1s0-8859-1
Chinese Simplified zh gb2312
Chinese Traditional zh TW bigh
Croatian hr is0-8859-2

iSeries Navigator for Wireless
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Language Language identifier Character set
Czech cs is0-8859-2
Dutch nl is0-8859-1
English en is0-8859-1
French fr is0-8859-1
French Belgium fr_ BE is0-8859-1
French Canadian fr CA is0-8859-1
French Swiss fr CH is0-8859-1
German de is0-8859-1
German Swiss de_CH is0-8859-1
Greek el is0-8859-7
Hungarian hu is0-8859-2
Italian it is0-8859-1
Italian Swiss it CH 150-8859-1
Japanese ja shift-jis
Korean ko euc-kr
Polish pl is0-8859-2
Portuguese pt is0-8859-1
Portuguese Brazilian pt_BR is0-8859-1
Romanian ro i50-8859-2
Russian ru windows-1251
Slovakian sk i50-8859-2
Slovenian sl is0-8859-2
Spanish es is0-8859-1

To Set the Default Language and Character Set for Netscape:

To set the language, select Edit > Preferences, and then click Languages (click Add to see a list of
language possibilities). Only the first one in the list is used.

To set the character set, select View » Character Set.
To Set the Default Language and Character Set for Internet Explorer:

To set the language, select Tools » Internet Options, and then click Languages button (click Add to see a
list of language possibilities). Only the first one in the list is used.

To set the character set, select View » Encoding. (You may have to select More to see the entire list.)

Connect to your central system

Connect to the central system using your wireless device.
To begin using iSeries Navigator for Wireless, enter the URL of your central system into your wireless

device. When pointing your device to the URL on your central system, use the following format.
Carefully specify that the end of the URL (/servlet/McYpvPervasive) is entered exactly as shown:
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host.domain:port / servlet/McYpvPervasive

host: The host name of the central system.
domain: The domain where the central system is located.
port: The port that the instance of the Web server is listening to.

Internet-ready telephone layout

If you have successfully connected to your central system,
the first thing you see when using iSeries Navigator for
Wireless on an Internet-ready telephone is the summary.
It shows you how current the information is, how many
systems are in your list, how many monitors you have
running, and how many tasks you have run in the last 24
hours. It will also tell you if any item needs attention by
showing an overall status of OK or Attention at the top
iSeries Mavigator of your display.
0L 15,01 0Z:00 AM
If OK is shown, all of your systems, monitors, and tasks
are running smoothly.

O httention it If Attention is shown, a system, monitor, or task needs
more attention. If a system is unavailable or if a monitor
1 ', Svsteans el or task has failed, an exclamation point is shown next to

the link with the item that needs attention. If a monitor
has triggered, a bell is shown next to the Monitors link.
3 Tasks=s LE Note: For telephones that do not support graphics, an
asterisk will be shown instead of a bell.

= Monitors (41

Mennu

PDA browser layout

The PDA browser layout is similar to the Internet-ready telephone. You will see a summary when first
using iSeries Navigator for Wireless, but because there is more room, the PDA browser also displays the
number of systems that are unavailable, the number of monitors that have triggered or failed, and the
number of tasks that have failed. Because some compatible browsers do not support graphics, an asterisk
(*) is used instead of a bell when displaying a triggered status.

Traditional browser layout

The traditional browser layout is exactly the same as the PDA browser layout. However, because of the
increased display size, it looks more basic. To make better use of desktop space, you can put a small
browser window in the corner of your PC to take advantage of Management Central functions while
working with other applications. If you are using a traditional Internet browser on your PC, you can
select Show all from the main menu to display all information on a full browser window.

After you have successfully connected to your system, you may want to customize your connection and
begin managing iSeries Navigator for Wireless.

Related concepts
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[‘Configure your wireless environment” on page 7|
Modify your web application server and firewall configuration so that iSeries Navigator for Wireless
will run properly.

[’Customize your connection”)

You may choose not to give users the ability to run commands from a wireless device but still provide
users with the ability to view monitors and system status. You may also want to change your task
details expiration. This page shows you how to limit user access to iSeries Navigator for Wireless
functions using Application Administration, as well as customize your task details retrieval length.

[‘Manage iSeries Navigator for Wireless” on page 18|

Find out how to manage iSeries systems from a wireless device. Use iSeries Navigator for Wireless to
interact with monitors in both Management Central and Integrated xSeries Servers. Run commands,
work with tasks and systems, and control user access.

Customize your connection

You may choose not to give users the ability to run commands from a wireless device but still provide
users with the ability to view monitors and system status. You may also want to change your task details
expiration. This page shows you how to limit user access to iSeries Navigator for Wireless functions
using Application Administration, as well as customize your task details retrieval length.

Limit user access to Management Central by manually removing functions from iSeries Navigator for
Wireless and by configuring Application Administration, and customize how long summary information
stays on your display before it is cleared.

Limit user access

Because you may want to limit a user’s capability to work with Management Central from a wireless
device, the following steps provide a way to let users view monitors and system status but not take any
action from iSeries Navigator for Wireless.

The following functions can be removed:

* Running commands on iSeries and integrated xSeries servers
* Starting or shutting down integrated xSeries servers

* Performing any action on a job (Hold, Release, End)

* Performing any action on a message (Reply, Delete)

* Starting, stopping, or restarting any monitor

To limit access, you must create the following options file:
1. In the integrated file system, create a file in the following directory:

Directory: QIBM/UserData/05400/MGTC/Pervasive/
File: QYPV_OPTIONS.OPT

2. Enter one of the following text strings into your file:
* readonly=yes
* readonly=no

A specific user can also have an options file named QYPV xxxxxx.OPT, where xxxxxx is the user ID. This

specific user file will override the QYPV_OPTIONS.OPT file allowing you to grant all users readonly=yes
authority, while granting specific users all access.
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Set task details retrieval length

Detailed information about tasks are available on the summary screen. These details are set to expire in
24 hours (tasks will still run, but no new data about a task will be retrieved from the central system and
displayed on your wireless device after 24 hours). You can change the expiration time by editing the
following option file:

Directory: QIBM/UserData/05S400/MGTC/Pervasive/
File: QYPV_OPTIONS.OPT

Add the following new entry to the option file (where XXXX, any number between 1-9999, is the number
of hours):

HOURS_OLD= XXXX

This is not case sensitive and can be either on a separate line or separated by a space from the
READONLY entry.

For example, your newly edited file might read:

READONLY=no

HOURS_OLD=48
This will give you full access and show tasks that have run in the last 48 hours.
Configure Application Administration

You can use Application Administration to control user access to the following functions in Management
Central: limit or grant access to monitors and commands. You should check to make sure the functions
selected in Application Administration are configured to match your desired preferences for connecting to
Management Central with a wireless device.

Examples:

* If a user is not authorized to Management Central but has a valid user ID on the iSeries, when they try
to connect to Management Central with a wireless device an authorization error message is displayed.

* If a user is authorized to Management Central but does not have Application Administration authority
to access monitors, no monitor information is displayed on the wireless device.

 If a user is not authorized to commands in Management Central, they will not be able to run a
command definition or run a command on an Integrated xSeries Server.

For more information on configuring and using Application Administration, see: Application
Administration.

Related concepts

[“Connect to your central system” on page 14|
Connect to the central system using your wireless device.

Application Administration|

“Work with tasks” on page 20|
You can view summary details for all your Management Central tasks.

['Run commands across multiple systems” on page 21|
iSeries Navigator for Wireless makes it easy to run commands on iSeries systems from your wireless
device.
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Manage iSeries Navigator for Wireless

Find out how to manage iSeries systems from a wireless device. Use iSeries Navigator for Wireless to
interact with monitors in both Management Central and Integrated xSeries Servers. Run commands, work

with tasks and systems, and control user access.

Series Movigater
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Related concepts

[“Connect to your central system” on page 14|

Using iSeries Navigator for Wireless is quite simple. Once
your central system is set up properly, you can connect to
your central system by pointing your internet-ready
telephone, PDA, or traditional web browser to the URL
on your central system. It connects to your central
system, asks you to log on, and shows you a summary of
the status of all your systems, monitors, and tasks. iSeries
Navigator for Wireless is designed with the assumption
that as long as you can find out that your systems,
monitors, and tasks are running smoothly, no other
information is required. You always have the option to
view more information, and you can even check the
detailed monitor metrics on systems that are running
smoothly. But generally, if everything is OK, it is assumed
that the summary is all you need to look at.

When you manage your systems with iSeries Navigator
for Wireless, you can feel confident when your wireless
device tells you that everything in your network of
iSeries servers is OK because you define what OK means
in your environment. If you set up the systems and
monitors you are interested in, and you tell the monitor
to trigger at a certain threshold, then all you have to do is
view the iSeries Navigator for Wireless summary page
and you can easily determine if everything is running
smoothly or if something needs attention.

The following pages help you use iSeries Navigator for
Wireless to interact with monitors in both Management
Central, iSeries, and Integrated xSeries Servers, run
commands, to work with tasks and systems, and to
control user access.

Connect to the central system using your wireless device.

[“Set up iSeries Navigator for Wireless” on page 3|

Covers the software and hardware that is required to use iSeries Navigator for Wireless. This also
helps you decide which kind of wireless device to use and what kind of applications you may need to

install and configure.

Work with iSeries systems

iSeries Navigator for Wireless allows you to view the properties of systems, add or remove a system, and

customize the system list.

You can interact with your iSeries systems from a wireless device by using iSeries Navigator for Wireless.
When the Systems link is selected, the list of all systems in your list is shown. You can customize your
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system list, and add only the systems you want to see, but the system must first be predefined as an
endpoint system in Management Central. If any systems in your list are not available, an exclamation
point is shown next to the system, and it is in bold. You can add and remove systems from your system
list, and you can also create a default system list, or create system lists for specific users.

Add and remove systems from your list:
1. Go to the menu, and select Add System or Remove System.

2. Select the system to add or remove.

Each system is also a link. Select a system to view properties on that system, as well as all the Integrated
xSeries Servers on that system.

Because adding systems to your list can be cumbersome, administrators can create a default system list
that becomes the default list for any user. The user can then customize that list to their own liking. This
feature can be useful if a group of users is interested in data stored on the same five to ten systems.

Create a default system list:
In the following directory, create the following file:

Directory: QIBM/UserData/0S400/MGTC/Pervasive/
File: QYPV_SYSTEMS.txt

After you have created this file, add all the systems that you want to include in your default list on one
line, separated by a comma. You can also create a system list for a specific user by creating the file QYPV
xxxxx.txt, where xxxxx is the user profile name.

Related concepts

[“Work with Integrated xSeries Servers”|
iSeries Navigator for Wireless provides you with the ability to manage your Integrated xSeries Servers
from your wireless device.

Work with Integrated xSeries Servers

iSeries Navigator for Wireless provides you with the ability to manage your Integrated xSeries Servers
from your wireless device.

If you have iSeries systems that have Integrated xSeries Servers (IXS), simply add the IXS systems to your
system list, and you have the ability to manage your Integrated xSeries Servers.

When you select an iSeries system, you can either link to the system properties, or you can view the IXS.
You will notice right away that the link to the IXS uses the same status as other iSeries Navigator for
Wireless functions. It tells you if any IXS needs attention, or if all of them are OK.

You can run Windows commands on a single or all Integrated xSeries Servers, and see the properties of
each one. The Windows commands are started as Management Central tasks, so you can keep track of
the commands you run. The image below shows IXS support in iSeries Navigator for wireless running in
a traditional browser format.
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Figure 2. Clicking on your Integrated xSeries Servers expands and displays the details of each system.

Note: To manage integrated xSeries servers from the iSeries, the user ID and password must be the same
on both the xSeries and iSeries.

For more information see Windows environment on iSeries.

Related concepts

[“Work with iSeries systems” on page 18§
iSeries Navigator for Wireless allows you to view the properties of systems, add or remove a system,
and customize the system list.

[Windows environment on iSeries|

Work with tasks

You can view summary details for all your Management Central tasks.

Click Tasks from the main summary window to view summary details for the following Management
Central tasks:

* Commands

* Packages and Products
¢ Inventory

* Fixes

* Collection Services

* Users and Groups

* System Values

For each type of task, the task summary displays the total number of tasks, the number of tasks that have
failed, and the number of tasks that have completed. Only the tasks run in the last 24 hours will display
in your list; if you have not run a Command in the last 24 hours, no information on Commands will
display on the task summary screen. Task information is set to expire in 24 hours, but you can change
this expiration by customizing your connection.

Click a specific task such as Commands to view the name or names of command tasks that are starting,
or that have completed or failed. Click the name of a specific task to view the endpoint system that the
task was or is running on.

Related concepts
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[‘Customize your connection” on page 16

You may choose not to give users the ability to run commands from a wireless device but still provide
users with the ability to view monitors and system status. You may also want to change your task
details expiration. This page shows you how to limit user access to iSeries Navigator for Wireless
functions using Application Administration, as well as customize your task details retrieval length.

Run commands across multiple systems

iSeries Navigator for Wireless makes it easy to run commands on iSeries systems from your wireless
device.

Use iSeries Navigator for Wireless to run any i5/0S command across multiple iSeries systems. You can
select Run Command from the summary page, which then asks you to select the system or system group
to run the command on. Or you can select a system from your system list and run a command on it.

When you select Run Command, you have the option of selecting an existing command definition
(defined by you in Management Central), or you can enter any command. Because entering text on a
telephone is cumbersome, using command definitions is extremely useful.

When commands are started, they are started as Management Central tasks. That way you can keep a
record of them, view the status across all systems, and view the overall status by looking at the summary
page. The summary page displays all the tasks you have run with Management Central (including iSeries
Navigator for Wireless) over the last 24 hours on your wireless device. After 24 hours, you need to use
iSeries Navigator on your PC to view a Command task. If you want to display task details on your
wireless device for longer than 24 hours, you can customize your connection.

The graphic below shows a sample of iSeries Navigator for Wireless command support in a PDA format.

Notice that if the command works, a plus sign (+) is displayed. On an internet telephone that supports
graphics, a successful command is represented by a smiling face icon.

iSeries Navigator for Wireless 21



WorkPad WorkPad

Figure 3. Viewing the status of your commands

Related concepts

[‘Customize your connection” on page 16

You may choose not to give users the ability to run commands from a wireless device but still provide
users with the ability to view monitors and system status. You may also want to change your task
details expiration. This page shows you how to limit user access to iSeries Navigator for Wireless
functions using Application Administration, as well as customize your task details retrieval length.

Related reference
[Command definition|

View and interact with monitors

If you have preconfigured monitors to run in Management Central, you can view and interact with
system monitors, message monitors, job monitors, file monitors, and B2B activity monitors using iSeries
Navigator for Wireless.

iSeries Navigator for Wireless allows you to view and interact with system monitors, job monitors,
message monitors, file monitors, and B2B activity monitors from a wireless device.
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Figure 4. Viewing monitor metrics on a wireless device

System monitors

You can work with system monitors to view the metrics and current values being monitored, as well as
the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work with
jobs listed in the monitor (display details, hold, release, and end).

Select the System monitors link to display a list of all your active system monitors (any monitors that are
stopped are not shown). If any monitors failed or are triggered, an exclamation point or bell appears next
to the monitor.

When you select a monitor, it shows all systems where that monitor is running, and if you select a
system, it shows you all metrics in that monitor and the values for the selected system.

Once you see the metric you are interested in, you can select the metric and it shows you the top 20

items that caused that metric value. For example, if you select CPU average, it shows you the top 20 jobs.
Or, if you select Disk utilization, it shows you the top 20 disk units.
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Figure 5. Viewing system monitor metrics on a wireless device

From the list of jobs, you can also select a job to see details, and you can work with that job by selecting

Hold, Release, or End.

You can refresh each page to refresh the list at any time. You can also select Home to display an updated

summary page.

Because display size is minimal, the system monitor metric names are shortened. Here is a table that
describes what iSeries Navigator for Wireless displays:

Monitor metric names in iSeries Navigator for Wireless:

System monitor metric names iSeries Navigator for Wireless name |Unit of measure
CPU Utilization (Average) CPU avg % busy

CPU Utilization (Interactive Jobs) CPU int jobs % busy

CPU Utilization (Interactive Feature) |CPU int feature %

CPU Utilization Basic (Average) CPU basic % busy

CPU Utilization (Secondary CPU 2nd workload %

Workloads)

CPU Utilization (Database Capability) | CPU DB %
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System monitor metric names

iSeries Navigator for Wireless name

Unit of measure

Interactive Response Time (Average)

Int resp avg

Seconds

Interactive Response Time
(Maximum)

Int resp max

Seconds

Transaction Rate (Average)

Trans rate avg

Transactions per second

Transaction Rate (Interactive)

Trans rate int

Transactions per second

Batch Logical Database I/O Batch DB IO 10/second
Disk Arm Utilization (Average) Disk util avg % busy
Disk Arm Utilization (Maximum) Disk util max % busy
Disk Storage (Average) Disk stg avg % full
Disk Storage (Maximum) Disk stg max % full
Disk IOP Utilization (Average) Disk IOP avg % busy
Disk IOP Utilization (Maximum) Disk IOP max % busy
Communications IOP Utilization Comm IOP avg % busy
(Average)

Communications IOP Utilization Comm IOP max % busy
(Maximum)

Communications Line Utilization Comm line avg % busy
(Average)

Communications Line Utilization Comm line max % busy
(Maximum

LAN Utilization (Average) LAN avg % busy
LAN Utilization (Maximum) LAN max % busy

Machine Pool Faults

Mch pool fault

Faults per second

User Pool Faults (Average)

Usr pool fault avg

Faults per second

User Pool Faults (Maximum)

Usr pool fault max

Faults per second

Related concepts

“Job monitors”

You can work with job monitors to view all jobs across systems that match monitor criteria. You can

see metrics and current values being monitored, and you can work with the jobs listed in the monitor
(display details, hold, release, and end).

["Message monitors” on page 26

You can work with message monitors to view all messages across systems that match monitor criteria.
And you can work with the messages listed in the monitor (display details, reply, and delete).

Job monitors

You can work with job monitors to view all jobs across systems that match monitor criteria. You can see
metrics and current values being monitored, and you can work with the jobs listed in the monitor
(display details, hold, release, and end).

Job monitors work the same way as the system monitors do in iSeries Navigator for Wireless. After you
create a job monitor in Management Central, you can start, stop, and view it in iSeries Navigator for
Wireless. You can also view the overall status of the job monitor, view the list of systems it is running on,
view the jobs that match the monitor criteria for each system, and work with a job using Hold, Release,

or End.

iSeries Navigator for Wireless
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Note: In Management Central, you can share job monitors across multiple users. When using iSeries
Navigator for Wireless, you can view all shared monitors, not just the job monitors that you have
created.

Related concepts

[“System monitors” on page 23|

You can work with system monitors to view the metrics and current values being monitored, as well
as the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work
with jobs listed in the monitor (display details, hold, release, and end).

Message monitors
You can work with message monitors to view all messages across systems that match monitor criteria.
And you can work with the messages listed in the monitor (display details, reply, and delete).

Message monitors work the same way as system monitors do in iSeries Navigator for Wireless. After you
create a message monitor in Management Central, it shows up in iSeries Navigator for Wireless, and you
can view the overall status of the message monitor, view the list of systems it is running on, view the
messages that match the monitor criteria for each system, and work with a message using Details, Reply,
or Delete.

Note: In Management Central, you can share job monitors across multiple users. When using iSeries
Navigator for Wireless, you can view all shared monitors, not just the job monitors that you have
created.

Related concepts

[“System monitors” on page 23|

You can work with system monitors to view the metrics and current values being monitored, as well
as the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work
with jobs listed in the monitor (display details, hold, release, and end).

File monitors
You can use a file monitor to notify you whenever a selected file has changed. Or, you can monitor for a
specified size or for specified text strings.

After you have created a file monitor in Management Central, you can start, stop, and display details
about the file monitor in iSeries Navigator for Wireless. The file monitor summary window displays the
iSeries system the monitor is running on, the path to the current file you are viewing, the size of the file,
the last date and time the file was modified, and the changed text that triggered the file.

Note: In Management Central, you can share job monitors across multiple users. When using iSeries
Navigator for Wireless, you can view all shared monitors, not just the job monitors that you have
created.

B2B activity monitors
If you have an application like Connect for iSeries configured, you can use a B2B activity monitor to

monitor your B2B transactions. From a wireless device, you can view metrics and current B2B transaction
values being monitored.

To use a business-to-business activity monitor, you must configure a consolidated system to log B2B
transactions collected from an application like Connect for iSeries.

After you set up a B2B activity monitor in Management Central, you can start, stop, and view details

about the activity monitor in iSeries Navigator for Wireless. View summary status on active transaction
duration and active transaction count triggers collected from the B2B activity monitor.
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Note: The B2B activity monitor data you want to view with iSeries Navigator for Wireless must be on a
system with V5R2 or a later release. Any B2B activity monitor data stored on an earlier system will
not work with iSeries Navigator for Wireless.

Related information for iSeries Navigator for Wireless

IBM related information contains links to related technical information.

Manuals

Listed below are the iSeries manuals and IBM Redbooks (in PDF format), Web sites, and Information

Center topics that relate to the iSeries Navigator for Wireless topic. You can view or print any of the
PDFs.

* |AS/400 Internet Security Scenarios: A Practical Approach| @

Learn how to exploit your AS/400 integrated network security functions. Today, network
administrators face the challenge of implementing layered security architectures to protect their
networks from the increasing sophistication of "hackers”. To provide all of the security needed within a
manageable budget is a complex task. This redbook explores all the native network security features
available on the AS/400 system such as IP filters, NAT, VPN, HTTP proxy server, SSL, DNS, mail relay,
auditing, and logging. It describes their use through practical examples.

Although AS/400 is not intended to be a firewall, the correct implementation of its rich set of network
security services, combined with routers or other Internet security appliances, may eliminate the need
for a separate firewall product. In some cases, it can provide an affordable solution for smaller sites.
The AS/400 network security functions can be used to enhance the security of environments where
routers with firewall security features are also used. This redbook is designed to meet the needs of
network administrators, consultants, and AS/400 specialists who plan to design, implement, and
configure AS/400 networks connected to the Internet and are evaluating alternatives to traditional
firewall products.

Web sites

For V4R5 information about iSeries Navigator for Wireless (previously known as Management Central
Pervasive), see:

« [iSeries Navigator for Wireless| -lﬁ’

Access Management Central functions on the go! The iSeries Navigator for Wireless homepage gives
you more information about this exciting solution for pervasive computing. This homepage covers
V4R5 and V5R1 release information.

For more information about iSeries Navigator, see:

* [iSeries Navigator| -lﬂ'

In addition to Management Central function, iSeries Navigator provides a wide variety of tools to
simplify iSeries management. Go to the iSeries Navigator homepage to find information about iSeries
Navigator, including functional release overviews, news about technical conferences, and other hot
topics. Click the link to Management Central for a variety of information including release updates,
functional overviews, FAQs, and more. For information about installing and getting started with iSeries
Navigator, be sure to see the [iSeries Navigator] topic in the Information Center.

For more information about Web application servers, see:

. |ASF Jakarta Tomcat| 'ld’

The Apache Software Foundation Jakarta project homepage provides detailed information covering the
Tomcat servlet engine.
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http://www.redbooks.ibm.com/abstracts/sg245954.html
http://www.ibm.com/servers/eserver/iseries/navigator/pervasive.html
http://www.ibm.com/servers/eserver/iseries/navigator/index.html
http://jakarta.apache.org/

* [WebSphere Application server -5

The latest information about the WebSphere Application Server for iSeries is located in the WebSphere
Application Server for iSeries product Web site.

Saving PDF files

To save a PDF on your workstation for viewing or printing:

1.
2.

3.
4.

Right-click the PDF in your browser (right-click the link above).

Click Save Target As if you are using Internet Explorer. Click Save Link As if you are using Netscape
Communicator.

Navigate to the directory in which you would like to save the PDFE.
Click Save.

Downloading Adobe Acrobat Reader

You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the Adobéd
(www.adobe.com/products/acrobat/ readstep.html)-.ld' .
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
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Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N

Rochester, MN 55901

US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

SUBJECT TO ANY STATUTORY WARRANTIES WHICH CANNOT BE EXCLUDED, IBM, ITS
PROGRAM DEVELOPERS AND SUPPLIERS MAKE NO WARRANTIES OR CONDITIONS EITHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NON-INFRINGEMENT, REGARDING THE PROGRAM OR TECHNICAL SUPPORT, IF ANY.
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UNDER NO CIRCUMSTANCES IS IBM, ITS PROGRAM DEVELOPERS OR SUPPLIERS LIABLE FOR
ANY OF THE FOLLOWING, EVEN IF INFORMED OF THEIR POSSIBILITY:

1. LOSS OF OR DAMAGE TO, DATA;

2. SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES, OR FOR ANY ECONOMIC CONSEQUENTIAL
DAMAGES; OR

3. LOST PROFITS, BUSINESS, REVENUE, GOODWILL, OR ANTICIPATED SAVINGS.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE ABOVE LIMITATIONS OR EXCLUSIONS
MAY NOT APPLY TO YOU.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

Approach
AS/400
AT

i5/0S
IBM
iSeries
Redbooks
WebSphere
xSeries
pSeries
zSeries

Other company, product, or service names may be trademarks or service marks of others.

Terms and conditions

Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either

express or implied, to the publications or any information, data, software or other intellectual property
contained therein.
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IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-1S" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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